	UBND QUẬN SƠN TRÀ
TRƯỜNG THCS LÝ TỰ TRỌNG
	NỘI DUNG KIẾN THỨC MÔN TIN HỌC LỚP 7

	
	Họ và tên HS: ..............................................
	Lớp 7/3


TUẦN 22 :
TIẾT 41:
BÀI 7 :       Trình bày và in trang tính
I. NỘI DUNG KIẾN THỨC BÀI HỌC (học thuộc và thực hành trên máy)
1.  Xem trước khi in
a) Xem trước khi in trong nhóm lệnh Print Preview 
- Mở bảng chọn File/PrintPrint Preview
[image: ]

















Thoát khỏi chế độ xem




* Lưu ý:
-Xem trước khi in là tính năng rất hữu ích,giúp chỉnh sửa bố cục trình bày để kết quả in trên giấy được như mong muốn
-Chỉ có thể sử dụng được lệnh xem trước khi in nếu máy tính được cài đặt ít nhất một trình điều khiển máy in (nhưng không cần có máy in)
2. Điều chỉnh ngắt trang
CÓ HAI KIỂU NGẮT TRANG
NGẮT TRANG ĐỨNG
Bước 1: Chọn cột phía bên phải vị trí bạn muốn chèn ngắt trang.
Bước 2: Sau đó chọn Page Layout → Breaks → Insert Page Break, lúc đó sẽ xuất hiện đường gạch nối chỉ vị trí ngắt trang.
[image: ]
b) Xem trước khi in trong lệnh View.
Nháy chọn lệnh View1
2
3









-Page Break Preview: Chế độ hiển thị trang tính dưới dạng ngắt trang.
-Normal: Chế độ hiển thị bình thường
-Page Layout: Chế độ hiển thị trang tính dưới dạng các trang in.
-Page Break Preview: Chế độ hiển thị trang tính dưới dạng ngắt trang.
2. Điều chỉnh ngắt trang.
- Chương trình bảng tính tự động phân chia trang tính thành các trang in (bằng cách chèn các dấu ngắt trang tự động) tùy theo độ rộng các cột, độ cao các hàng, kích thước và lề trang giấy.
Bước 1.
Bước 2.





















[image: ]














Page 1 (trang 1)
Page 2 (trang 2)











Nét đứt trên trang khi ngắt trang














 * Các bước thực hiện:
+ Bước 1: Hiển thị trang tính trong chế độ Page Break Preview.
+ Bước 2: Đưa con trỏ chuột vào dấu ngắt trang mà em cho rằng không hợp lí, con trỏ chuột có dạng        [image: ]           hoặc dạng   [image: ]    .
+ Bước 3: Kéo thả dấu ngắt trang đến vị trí em muốn.
Chú ý: Để thoát khỏi chế độ ngắt trang (hoặc chế độ trang in) em nháy  chọn nút lệnh      View->Normal.






3. Đặt lề và hướng giấy in.Lề trên (Top)
Lề dưới (Bottom)
Lề trái (Left)
Lề phải (Right)

Trang đứng khi xem toàn màn hình






















 Cách đặt lề cho trang in: 
- Bước 1: Mở dải lệnh  Page Layout và nháy chọn  nút  phía dưới trong nhóm  Page Setup  xuất hiện hộp thoại
- Bước 2: chọn mục trang Margins xuất hiện: thay đổi các thông số vào các ô 
+ Top ( lề trên)
+ Bottom ( lề dưới)
+ Left ( lề trái)
+ Right (lề phải)











Các bước thực hiện chọn hướng giấy in.
* Cách 1: Vào Page Layout/ Orientation/ xuất hiện 2 hướng trang: 
+ Portrait  (trang đứng) 
+ Landscape (trang ngang).





* Cách 2: Vào Page Layout/ Page Setup/ xuất hiện 2 hướng trang đứng và trang ngang.
[image: ][image: ]










4. In trang tính.
* Cách thực hiện in trang tính. 
Cách 1: Vào File / Print / (hoặc                          ).   
Cách 2 : Nhấn tổ hợp phím (Ctrl + p)  











*  Cách thực hiện in trang tính: 
- Chọn File / Print xuất hiện hộp thoại 








*  Các bước thực hiện in trang tính. 
In tất cả
In từ trang …
In trang cụ thể
đến trang…
Số trang in ra
Chọn máy in
Kết thúc










=> Lưu ý: Khi chọn lệnh in (Print) có thể xem trước kết quả ngắt trang in trong lệnh(Preview)










Bài tập (Làm vào vở học)Câu 1.Để xem trước khi in em chọn lệnh nào trong các lệnh sau:
  a) Vào File / print /  
  b) Vào View / PageLayout
  c) Vào File / Page Setup
 d) Vào Insert / Clip Art


[image: !CID_0~1]




      Câu 2. Để điều chỉnh chế độ ngắt trang em chọn lệnh nào trong các lệnh sau:
   a) Vào View / Normal/Print preview
   b) Vào View / Page Break Preview
   c) Vào Home / Delete
  d) Vào Insert / Picture






Câu 3. Để chọn hướng giấy in vào theo chiều dọc em chọn lệnh Page Layout rồi chọn Page Setup trong thẻ Page rồi chọn ... 
   a) 
b)
c) [image: ]
d) Tất cả sai










Câu 4. Để căn lề (trái, phải, trên, dưới) em chọn lệnh Page Layout /Page Setup / rồi chọn .…. 
a)  Microsoft Excel
b) Page Break Preview
c) Margins 
d) Tất cả đều sai




Câu 5. Để in trang tính vào File / rồi chọn lệnh …… 
a) 
b) 
c) 
d) Tất cả đều đúng









DẶN DÒ
- Làm các bài tập trong SGK trang 73.
- Đọc phần tìm hiểu mở rộng sgk trang 73-74.
- Đọc bài mới “ Bài thực hành 7 in danh sách lớp em”.
III. TRAO ĐỔI, PHẢN HỒI VỀ KIẾN THỨC BÀI HỌC CỦA HỌC SINH
................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ ................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ 
TIẾT 42 Bài thực hành 7: In danh sách lớp em
TUẦN 23:
TIẾT 43:
BÀI 8:	Sắp xếp và lọc dữ liệu
	I. NỘI DUNG KIẾN THỨC BÀI HỌC (học thuộc và thực hành trên máy)
1. Sắp xếp dữ liệu
B1. Chọn một ô trong cột em cần sắp xếp dữ liệu


B2. Nháy nút (Sort Ascending) để sắp xếp theo thứ tự tang dần hoặc  (Sort Descending) để sắp xếp giảm dần.
[image: ]
* Chú ý:
- Cột có dữ liệu kí tự được sắp xếp theo bảng chữ cái tiếng anh

- HiÓn thÞ nót lÖnh  trªn thanh c«ng cô chuÈn.
2. Lọc dữ liệu
Bước 1. Chuẩn bị
1. Chọn một ô trong vùng có dữ liệu cần lọc
2. Vào Data\Filter\AutoFilter
Bước 2. Lọc
1. Nháy vào mũi tên tại tiêu đề cột cần lọc
2. Chọn giá trị cần lọc

· Bước 1: Chuẩn bị
Xuất hiện các mũi tên xuất hiện cạnh các tiều đề cột









· Bước 2: Lọc dữ liệu
1.Nháy mũi tên để xem các giá trị chuẩn










Một số lưu ý:
· Sau khi có kết quả lọc theo giá trị trong một cột, có thể chọn cột khác để tiếp tục lọc các hàng thỏa mãn thêm các tiêu chuẩn trên những cột đó.
· Hiển thị lại toàn bộ danh sách: Data  Filter  Show All
· Thoát khỏi chế độ đặt lọc: Data  Filter và nháy chuột xoá đánh dấu AutoFilter


3. Lọc các hang có giá trị lớn nhất hoặc nhỏ nhất
B1. Nhấn chuột vào mũi tên cột cần lọc, chän Top 10 -> xuất hiện cửa sổ 


B2. Chọn Top (lớn nhất), hoặc Bottom (nhỏ nhất)
B3. Chọn hoặc nhập số hàng cần lọc
B4.  Nhấn OK
II. BÀI TẬP (làm vào vở)
Câu 1: Cho biết người sử dụng đã làm thao tác gì?
A. Sắp xếp dữ liêu ở cột C theo chiều tăng dần;
B. Sắp xếp dữ liệu ở cột D theo chiều tăng dần;
C. Sắp xếp dữ liệu ở cột E theo chiều tăng dần;
D. Cả 3 kết luận trên đều sai.

Trước 
Sau













Câu 2: Hãy quan sát các hình dưới đây, cho biết thầy giáo đã thực hiện thao tác gì?
A. Lọc ba bạn có số phiếu tổng kết cao nhất;
B. Lọc ba bạn có số phiếu tại cột Vui vẻ cao nhất;
C.  Lọc ba bạn có số phiếu tại cột Dịu Dàng cao nhất;
D.  Cả 3 đều sai.
Trước 
Sau 





















	Câu 3: Sau khi lọc theo yêu cầu thì dữ liệu trong cột được lọc đó sẽ thay đổi thế nào?
A. Sẽ được sắp xếp tăng dần;
B. Sẽ được sắp xếp giảm dần;
C. Dữ liệu được giữ nguyên theo vị trí ban đầu;
D. Cả 3 đáp án trên đều sai.












Câu 4: Lệnh: Data  Filter  Show all dùng để làm gì?
A. Hiển thị các kết quả vừa lọc
B. Sắp xếp cột vừa lọc theo thứ tự tăng dần
C. Hiển thị tất cả dữ liệu trong bảng vừa lọc.
D. Cả 3 đáp án trên đều sai





DẶN  DÒ (làm vào vở)
· Để sắp xếp danh sách dữ liệu em có thể dung lệnh gì của EXCEL?
· Lọc dữ liệu là gì? hãy nêu một vài ví dụ thực tế?
· Hãy nêu các bước cần thực hiện khi lọc dữ liệu?
· Thực hành trên máy nếu có điều kiện.
III. TRAO ĐỔI, PHẢN HỒI VỀ KIẾN THỨC BÀI HỌC CỦA HỌC SINH
................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ ................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ 
TIẾT 44	 Bài thực hành 8: Sắp xếp và lọc dữ liệu

TUẦN 24:
TIẾT   45,46:
BÀI :	                         ÔN TẬP
	I. NỘI DUNG KIẾN THỨC BÀI HỌC
1. Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.
2. Cũng cố cách sắp xếp và lọc dữ liệu.
II. BÀI TẬP
		Câu 1 :
	Để thêm cột trên trang tính ta thực hiện như sau:

	
	A.
	 Insert / Rows                                    	

	
	B.
	 Insert / Columns

	
	C.
	 Table / Columns                              	

	
	D.
	 Table / Rows

	Câu2 :
	Để di chuyển nội dung ô tính ta sử dụng nút lệnh nào sau đây?

	
	A.
	 [image: ] (copy).

	
	B.
	 [image: ] (cut).

	
	C.
	 [image: ] (paste).                                                     

	
	D.
	 [image: ]  (new)

	Câu 3 
	Để sao chép nội dung ô tính ta sử dụng nút lệnh nào sau đây?

	
	A.
	 copy				

	
	B.
	 cut 

	
	C.
	 paste 			

	
	D.
	 new.


	Câu 4 
	Muốn xóa một hàng hoặc cột ta chọn hàng hoặc cột cần xóa rồi sử dụng lệnh nào sau đây?

	
	A.
	Edit / clear					

	
	B.
	Edit / paste

	
	C.
	Edit / cut 

	
	D.
	Edit / Delete


	Câu5 
	Nối ý của cột A với mỗi ý ở cột B để có kết quả đúng.

	A
	B

	1. chọn một ô
2. chọn một hàng
3. chọn một cột
4. chọn một khối

	A. nháy chuột tại nút tên hàng
B. nháy chuột tại nút tên cột
C. đưa con trỏ chuột tại nơi đó và nháy chuột.



Câu 6:   Trong các nút lệnh [image: ] [image: ] [image: ] [image: ] nút lệnh nào dùng để lưu  bảng tính
A. [image: ]              B .[image: ]             C. [image: ]                D. [image: ]
C©u 7: §Ó in trang tÝnh ta dïng lÖnh?
          a. File/Print                          b. File/ Print Preview
          c. Preview                            d. Edit/ Print Preview
C©u 8: §Ó thay ®æi th«ng sè lÒ d­íi trong trang Margins ta thay ®æi môc nµo?
a. Bottom         b.Top          c. Left               d. Right
C©u 9: §Ó s¾p xÕp d÷ liÖu gi¶m dÇn ta dïng nót lÖnh:
a.  [image: ] .   b. [image: ]	c. [image: ]   d. C¶ a, b, c ®Òu sai.
C©u 10: §Ó  hiÓn thÞ toµn bé danh s¸ch nh­ng vÉn ë chÕ ®é läc:
         a. Data/Filter/ Auto Filter   b. Data/ Filter/ Show All
         c. Data/ Show All                d. C¶ a, b vµ c ®Òu sai


	Thùc hµnh 

	Cho bảng tính:

	
	A
	B
	C
	D
	E
	F
	G

	1
	BẢNG ĐIỂM MÔN TIN HỌC CĂN BẢN

	2
	STT
	Họ và tên
	THCB
	WORD
	EXCEL
	Tổng điểm
	Trung bình

	3
	1
	Nguyễn Hảo Hớn
	10
	8.5
	8
	?
	?

	4
	2
	Trần Lạc Gia
	7
	9
	8.5
	?
	?

	5
	3
	Lý Nhược Đồng
	9
	8
	6.5
	?
	?

	6
	4
	Mai Trúc Lâm
	9
	8
	5
	?
	?

	7
	5
	Nguyễn Thị Thúy
	7
	9
	10
	?
	?

	8
	6
	Trần Mai Lan
	7
	6
	5
	?
	?

	9
	7
	Lý Thanh Thanh
	6.5
	9.5
	7
	?
	?

	10
	
	Điểm cao nhất
	?
	?
	?
	
	

	11
	
	Điểm thấp nhất
	?
	?
	?
	
	



Yêu cầu:

1/ Nhập nội dung bảng tính theo mẫu trên. (2 điểm)
2/ Lưu với tên và đường dẫn sau: D:\ Họ và tên học sinh - lớp (1 điểm)
3/ Dùng hàm để tìm điểm cao nhất, điểm thấp nhất. (3 điểm)
4/ Dùng hàm để tính tổng ba môn của mỗi học sinh (2 điểm)
5/ Tính điểm trung bình của các môn (2 điểm)





	III. TRAO ĐỔI, PHẢN HỒI VỀ KIẾN THỨC BÀI HỌC CỦA HỌC SINH
................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ .......................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................... 
TIẾT 47 KIỂM TRA MỘT TIẾT 
TUẦN 25:
TIẾT 48:
BÀI 9 :    Trình bày dữ liệu bằng biểu đồ
	I. NỘI DUNG KIẾN THỨC BÀI HỌC (học thuộc )
1. Minh họa dữ liệu bằng biểu đồ
        Biểu đồ là cách minh họa dữ liệu trực quan,giúp dễ so sánh số liệu, dự đoán xu thế tăng giảm của các số liệu
2. Một số dạng biểu đồ
Biểu đồ cột
Biểu đồ đường gấp khúc
Biểu đồ hình tròn
Dùng để so sánh dữ liệu có trong nhiều cột 
của bảng dữ liệu.
Dùng để so sánh dữ liệu 
và dự đoán xu thế tăng 
hay giảm của dữ liệu.
Dùng để mô tả tỷ lệ 
của từng dữ liệu 
so với tổng các dữ liệu.


















3. Tạo biểu đồ Bước 1:Chọn 1 ô trong miền có dữ liệu cần vẽ biểu đồ.
Bước 2: Có 2 cách
C1:
Nháy chuột vào biểu tượng       
 C2:
Vào Insert/Chart
H×nh 100
Chart Wizard trên thanh công cụ.
Sau khi thực hiện xong thì xuất hiện hộp thoại như hình.




















a/Chọn dạng biểu đồ
Trªn hép tho¹i H×nh 100
1.Chọn nhóm biểu đồ
2.Chọn dạng biểu đồ
3.Nháy next để sang bước 2











b/ Xác định miền dữ liệu
Sau khi nháy nút Next ở Hình 102 xuất hiện hộp thoại như hình 105.
Hình 105
2.Chọn dãy dữ liệu cần minh họa theo hàng hay cét
3.Nháy Next để sang hội thoại tiếp theo 
1.Kiểm tra miền dữ liệu và sửa lại nếu cần

















c/ Các thông tin giải thích biểu đồ
Hình 109
1. Cho tiêu đề biểu mẫu
2. Chú giải trục ngang
3. Chú giải trục đứng
4. Nh¸y chuét chän Next















Chọn vị trí lưu biểu đồ
d/ VÞ trÝ ®Æt biÓu ®å
Nháy nút Next ở Hình 109 xuất hiện hội thoại  như hình 110.
Hình 110
Nh¸y Finish ®Ó kÕt thóc













II. BÀI TẬP
     B. Phải xoá biểu đồ cũ và thực hiện lại các thao tác tạo biểu đồ.
A. Nháy nút          trên thanh công cụ biểu đồ và chọn kiểu thích hợp
    C. Nháy nút       trên thanh công cụ biểu đồ và chọn kiểu thích hợp
     D. Đáp án khác
Câu 1: Muốn thay đổi kiểu biểu đồ đã được tạo ra, em có thể




[image: ]


[image: ]


Câu 2: Cho bảng thống kê sử dụng đất ở Việt Nam. Hãy chọn dạng biểu đồ thích hợp nhất để nhận xét tình hình sử dụng đất ở nước ta.
A. Biểu đồ cột
 B. Biểu đồ đường gấp khúc
C. Biểu đồ hình tròn
D. Biểu đồ dạng khác









A.Minh họa dữ liệu trực quan
B.Dễ so sánh dữ liệu
C.Dễ tính toán hơn
D.Dễ dự đoán xu thế tăng hay giảm của dữ liệu
Câu 3: Mục đích của việc sử dụng biểu đồ là gì? Hãy chọn những đáp án đúng













A. Hàng đầu tiên của bảng số liệu
B. Cột đầu tiên của bảng số liệu
C. Toàn bộ dữ liệu
D. Phải chọn trước miền dữ liệu, không có ngầm định
Câu 4: Khi vẽ biểu đồ, chương trình bảng tính ngầm định 
miền dữ liệu để tạo biểu đồ là gì? 











DẶN DÒ
Học thuộc và làm bài tập vào vở
III. TRAO ĐỔI, PHẢN HỒI VỀ KIẾN THỨC BÀI HỌC CỦA HỌC SINH
................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................ ................................................................................................................................................
TIẾT 49 Bài thực hành 9: Tạo biểu đồ để minh họa (Kiểm tra 15 phút thực hành)
TIẾT 50 Bài thực hành 10: Thực hành tổng hợp 
TUẦN 27:
TIẾT 51,52:
BÀI  :                                                ÔN TẬP
	I. NỘI DUNG KIẾN THỨC BÀI HỌC (học thuộc )
PHẦN I: ĐỊNH DẠNG TRANG TÍNH
1. Định dạng phông chữ, cỡ chữ, kiểu chữ:
a. Thay đổi phông chữ:
          B1: Chọn ô (hoặc các ô) cần định dạng
          B2: Nháy chuột vào mũi tên ở ô Font
          B3: Chọn phông chữ thích hợp
b.   Thay đổi cỡ chữ:
B1: Chọn ô (hoặc các ô) cần định dạng
B2: Nháy chuột vào mũi tên ở ô Font size
B3: Chọn cỡ chữ thích hợp
c.   Thay đổi kiểu chữ:
B1: Chọn ô (hoặc các ô) cần định dạng
B2: - Nháy chuột vào nút lệnh Bold          để chọn kiểu chữ đậm
       - Nháy chuột vào nút lệnh Italic         để chọn kiểu chữ nghiêng
       - Nháy chuột vào nút lệnh Underline         để chọn kiểu chữ gạch chân




























2 . Định dạng màu chữ:
B1: Chọn ô ( hoặc các ô) cần định dạng
B2: Nháy chuột vào mũi tên ở ô Font color
B3: Chọn màu chữ thích hợp
3.   Căn lề trong ô tính:
B1: Chọn ô ( hoặc các ô) cần định dạng
B2: - Nháy chuột vào nút lệnh Center  để căn giữa ô
       - Nháy chuột vào nút lệnh Align left  để căn thẳng lề trái
       - Nháy chuột vào nút lệnh  Align right  để căn thẳng lề phải
       - Nháy chuột vào nút lệnh Merge and center  để gộp các ô thành một ô và căn giữa















4.   Tăng hoặc giảm số chữ số thập phân của dữ liệu số:
B1: Chọn ô ( hoặc các ô) cần định dạng
B2: - Nháy chuột vào nút lệnh Decrease Dicimal để giảm số chữ số thập phân
       - Nháy chuột vào nút lệnh Increase Dicimal  để tăng số chữ số thập phân







5. Tô màu nền và kẻ đường biên:
a. Tô màu nền:
B1: Chọn ô ( hoặc các ô) cần tô màu nền
B2: Nháy chuột vào mũi tên ở ô Fill color 
B3: Chọn màu chữ thích hợp






b.   Kẻ đường biên:
B1: Chọn ô ( hoặc các ô) cần kẻ đường biên
B2: Nháy chuột vào mũi tên ở nút lệnh Borders
B3: Chọn kiểu kẻ đường biên thích hợp




PHẦN II: TRÌNH BÀY VÀ IN TRANG TÍNH
1. Xem trước khi in:
Cách 1: Nháy chuột vào nút lệnh: Print Preview            trên thanh công cụ
Cách 2: Vào bảng chọn File \ chọn Print  Preview
2.   Điều chỉnh ngắt trang:
B1: Vào bảng chọn View \ chọn Page Break Preview
B2: Đưa chuột vào đường kẻ xanh, con trỏ chuột chuyển thành dạng           (đường kẻ ngang) hoặc dạng         (đường kẻ đứng)
B3: Kéo thả đường kẻ xanh đến vị trí thích hợp











3.  Đặt lề và hướng giấy in:
a. Đặt lề:
B1: Vào dải lệnh Page layout \ chọn Page Setup
B2: Nháy chuột mở trang Margins
B3: Thay đổi số trong các ô :  Top ( lề trên),  Bottom (lề dưới)
				         Right (lề phải),   Left (lề trái)
B4: Chọn Ok. [image: ]
 
B1: Vào dải lệnh Page layout \ chọn Page Setup
B2: Nháy chuột mở trang Page
B3: Chọn Portrait (hướng giấy đứng)
       Chọn Landscape (hướng giấy ngang)
B4: Chọn Ok.
				





















B1: Vào bảng chọn File \ chọn Print
B2: Điền số trang cần in vào mục From…to..
B3: Chọn Ok
4. In trang tính:





PHẦN III: SẮP XẾP VÀ LỌC DỮ LiỆU:
1. Sắp xếp dữ liệu:
B1: Nháy chuột chọn một ô trong cột cần sắp xếp dữ liệu
B2: Nháy chuột vào nút lệnh            để sắp xếp theo thứ tự tăng dần
Hoặc nháy chuột vào nút lệnh            để sắp xếp theo thứ tự giảm dần
 
2. Lọc dữ liệu: 
B2: Vào bảng chọn Data \ chọn Filter 
B3: Nháy chuột vào nút           trên hàng tiêu đề cột
B4:Chọn giá trị cần lọc trong danh sách hiện ra/ ok
B1: Nháy chuột chọn một ô trong vùng có dữ liệu cần lọc
Lưu ý: Ta có thể lọc các hàng có giá trị lớn nhất (hoặc nhỏ nhất) nếu ở B4 ta chọn Top 10. khi đó hộp thoại xuất hiện ta chọn Top( lớn nhất) hoặc Bottom (nhỏ nhất)  sau đó chọn số hàng cần lọc và nháy OK























BÀI TẬP
I.Trắc nghiệm
Câu 1. Lệnh chọn phông chữ nằm trong nhóm lệnh?
A. Font       B. Paragraph       C. Number       D. Cells
Câu 2. Trong các biểu đồ sau đây, biểu đồ nào là biểu đồ cột:
A. [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]       B. [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]       C. [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]       D. [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]

Câu 3. Phát biểu nào sau đây là sai?
A. Biểu đồ cột không thích hợp để so sánh dữ liệu có trong nhiều cột.
B. Biểu đồ đường gấp khúc dùng để so sánh dữ liệu và dự đoán xu thế tăng hay giảm của dữ liệu.
C. Biểu đồ hình tròn thích hợp để mô tả tỉ lệ của giá trị dữ liệu so với tổng thể.
D. Biểu đồ cột thích hợp để so sánh dữ liệu có trong nhiều cột.
Câu 4. Để vẽ đoạn thẳng trong phần mềm Geogebra, em chọn công cụ:
A. Tên hàm số:=biểu thức hàm số chứa y
B. y:=biểu thức hàm số chứa x
C. Tên hàm số:=biểu thức hàm số chứa x và chứa y
D. Tên hàm số:=biểu thức hàm số chứa x
Câu 5. Trong cửa sổ CAS của phần mềm Geogebra có bao nhiêu chế độ tính toán?
A. 3       B. 2       C. 1       D. 4
Câu 6. Cho bảng tính sau:
[image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]
Để sắp xếp bảng điểm tăng dần theo điểm tổng cộng, thực hiện:
A. Chọn ô H3, chọn tiếp [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)].
B. Chọn ô I3, chọn tiếp [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]
C. Chọn ô H3, chọn tiếp [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]
D. Chọn ô I3, chọn tiếp [image: Đề kiểm tra Học kì 2 Tin học 7 có đáp án (Đề 1)]
Câu 7. Để chèn thêm hàng em thực hiện các thao tác nào sau đây:
A. Insert -> Insert Sheet       B. Insert -> Insert Sheet Columns
C. Insert -> Insert Sheet Rows       D. Insert -> Insert Cells
Câu 8: Trình bày dữ liệu bằng biểu đồ nhằm:
A. Rút gọn dữ liệu
B. Dễ so sánh, dự đoán xu thế tăng giảm dữ liệu, trực quan sinh động
C. Đẹp lôi cuốn người tiếp xúc
D. Không nhằm mục đích gì cả
II. TỰ LUẬN (6 điểm)
Câu 1: Trình bày các bước tạo biểu đồ? (2 điểm)
Câu 2: Hãy nêu các bước để thực hiện định dạng phông chữ ? (1điểm)
Câu 3: (3 điểm). Cho bảng kết quả học tập như sau:
	
	A
	B
	C
	D
	E
	F
	G

	1
	STT
	Tên
	Toán
	Lý
	Hóa
	Sinh
	TBM

	2
	1
	Nguyễn Thị Mỹ Dung
	7
	7
	8
	7
	7.3

	3
	2
	Trần Thị Huyền Trang
	8
	7
	8
	9
	8.0

	4
	3
	Đậu Khánh Vân
	9
	10
	6
	8
	8.3

	5
	4
	Hoàng Ngọc Bích Trâm
	9
	9
	8
	7
	8.9


a) Hãy sắp xếp cột TBM theo thứ tự giảm dần ?
b) Hãy lọc ra 2 bạn có “ĐTB” thấp nhất?

DẶN DÒ
· Học thuộc nội dung kiến thức
· Làm bài tập vào vở
III. TRAO ĐỔI, PHẢN HỒI VỀ KIẾN THỨC BÀI HỌC CỦA HỌC SINH
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